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Preface

Preface

Purpose

This document describes how to install Oracle Payment Interface (OPI) Release 19.1
with the Oracle Hospitality RES 3700 Oracle Gateway Device Handler (OGDH) and it
explains how to configure RES 3700 for OPI with OGDH.

Audience

This document is intended for installers and system administrators of OPI and OGDH.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

*  Product version and program/module name

*  Functional and technical description of the problem (include business impact)
* Detailed step-by-step instructions to re-create

° Exact error message received and any associated log files

* Screenshots of each step you take

Documentation

Product documentation is available on the Oracle Help Center at
http://docs.oracle.com/en/industries/hospitality/

Revision History

Date Description of Change
February 2019 Initial publication.
March 2019 *  Updated formatting and cover page with new template.

* Updated details for tender mapping in Chapter 2.
* Added not supported functionality to Chapter 6.

July 2019 Updated security bugs in few chapters

October 2023 Removed the MySQL 5.6 version across the document as the OPI

installer no longer supports
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Pre-Installation

Before You Start the Installation

ORACLE

Consider the following guidelines before installing Oracle Payment Interface (OPI):

IF UPGRADING OPI, YOU MUST READ THE UPGRADING THE OPI SECTION FIRST.

Verify that your environment meets the following requirements:

Upgrading from OPI 6.1and higher to OPI 19.1 is supported.
Upgrading from MGDH 6.1 and higher to OGDH 19.1 is supported.
Upgrading from previous versions of MPG to OPI is not supported.

If an MGDH installation prior to 6.1 exists, go to Programs and Features and uninstall
the previous MGDH installation. Then install the new OGDH.

OPI supports JRE 8 and it is required to use JRE 8U152 or above JRE 8 build only to
support all the currencies

It is required to use JRE 8U131 or above build of JRE8 for OGDH machine if you do
OGDH installation without connecting to RES database

Verify with the merchant whether they use TSR (table service) or QSR (quick
service), or both. (No tips allowed in QSR.)

Verify with the merchant whether they would like “Refund” functionality activated or
not. The merchant needs to control the privilege for this function.

Verify with the merchant whether they would like “Sale&Cash” functionality activated.
This allows a guest to get cash back with their purchase. This is only available for
QSR.

At least 6 GB of free disk space is required for OPI installation.
You must install both OGDH and OPI as an Administrator.

You will need to know a Micros database user name and password to install the Pay
at Table portion of OPI.

If upgrading OPI from prior 6.1 releases you will need to know the database root user
account password.

Obtain the following information before installing the software:

Confirm Merchant ID’s
Confirm receipt header details
Tender Media numbers for each card type

IP of OPI Server

1-1



Chapter 2
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IP of POS Server
Workstation ID’s and IP’s that will integrate to a PINPAD

OGDH OPI Solution

Installing OGDH

To install OGDH:

1.

3.

In Microsoft Windows, log in as an administrator, and then run the
OGDH _OPI 19.1.0.0.exefile.

Click Next on the Welcome to the Install Shield Wizard screen to proceed with
installation.

On the OGDH Installer Checking dependencies screen. Click Next.

0GDH Installer 2|

ORACLE

Checking dependencies

This machine is verified for required software.

Below POS snftware from Qrade MICROS is deterted on this romnoter
Question 20

L In order to connect to Sybase the Sybase driver will be required. The
y' following dialog will request the path for the Sybase driver. Continue?

ves || Mo

I < Back H Mext = ][ Cancel I

Click No to request for the Sybase driver or click Yes to select the path for Sybase
driver that can be used to connect to RES database.

Select the install location, and then click Next.
On the Ready to Install the OGDH screen, click Install.

On the Connect to RES database screen, click Skip DB Connection or if you
selected the Sybase driver on step 4, then click Connect.

Below steps are assumed for Skip DB Connection
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10.
11.
12.
13.
14.
15.
16.

17.

18.

19.
20.

Chapter 2
OGDH OPI Solution
Select the Currency from the drop-down list, and then click Next.
In Micros control panel take Restaurant to Database level.

Open POS Configurator | Revenue Center | RVC Transactions to see the correct
RVC info.

Click Add RVC to add a new record for each revenue center shown in POSCFG, and
then fill in the correct revenue center information for all fields and all revenue centers:

RVC ID = Revenue center “Number”
Device Merchant ID = Merchant ID

Mode: TSR for all RVCs that allow tipping. QSR for any RVC that does not allow
tipping.

Receipt Header/Trailer: Click Edit to add header and trailer lines for each RVC.
Click Next.

Open POSCFG | Sales | Tender/Media to see tender information.

Enter the correct tender number for each tender. Leave unused tenders blank.
For “GC Cash-out SVC” record number go to POSCFG Sales | Service Charges.
Click Next.

The next screen shows unused tenders in red.

Verify the tender settings are correct and click Next.

The Extra Tender mapping configuration screen is for adding any tenders not
shown on the previous tender screen.

If you have any Extra tenders that were not listed on the previous page, you may
enter them here.

You must first select the “Enable extra tenders” check box option.
Click Next.
Verify extra tender settings are correct, and then click Next.

Event 17 do Void: For RES only, “must be enabled if you want to enable void
feature”.

Allow Tab Auth: Enable if initial authorizations are allowed.

Adjust Tip: Enable if ability to adjust tip amount is needed.

Gift Card Support: Enable if gift cards will be sold.

Use GC denominated value: Enable if they sell gift cards that have a set price.

Leave this disabled if gift cards are sold as an open amount that the operator types
in.

Print Failed Receipt: Enable if vouchers should print when a card is declined.
Click Next.
Host / IP Address: Enter IP address of the OPI server PC.
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21.
22.
23.
24.

25.

26.
27.

Port: Port used to communicate to OPI.
Tab Auth Amount: Initial authorizations will default to this preset amount.
Receipt Limit Amount: Enter the amount, below which vouchers should not print.

Look in POSCFG | Sales | Menu Items for the GC activation menu item and GC
top-up menu item record numbers, if applicable.

Click Next.
OPI Service Configuration screen appears.
Select the modules to install. Typically all of them.

Click Save.

' OGDH Installer

28.

Installshield Wizard Complete

The Installshield Wizard has successfully installed OGDH.
Click Finish to exit the wizard.

< Back Cancel

Click Finish.

POSCFG Configuration for OGDH

Employee Class / Refund

The ability to perform a refund is controlled by the SIM privilege 4 option. To access,
select Employee Classes > Privileges > Privilege Options.

Only enable this option with the merchant’s permission and only for the employee class
they specify.

ORACLE
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[ Employee Classs fo e ]
File Edit Record Help
Employee Classes R T A 2 i @2
101 Server Table View Sort By |Mumber v > = @ %
Recard View I Table Wiew ]
Number Name e Guest Checks | Prlnllni[iv"J es\r"ou:l / Feturm | Options ‘ Del!very | Cash Management
y Gorver T able Wiew a . Clock In / Sign In . J | . Pmcedures. | Tranzactions
102 | Server Privilege Levels  Privilege Dptions | G55 Piivieges | TMS Privileges |
n 103 Cashier ¥ Show Ingredient Amt System Interface Module
A 104 | Timek.eeping Only [~ Allow all Dffline reports [~ SIM privilege 1
n 105 Busser [ allow signed-in employee Offline reports [~ 5IM privilege 2
106 Host v Use Repors [ 5SIM privilege 3
B 107 | Server- Seclions [ Use Alert Viewer v SIM privilege 4
N - : Clear all totals
108 Srvr- Fieq Finger Print Auth r "
— ; [¥ Access to apps using password D Credit Card Batch
109 Srur Thl View- Mag Card Req X .
] 209 Bartend [~ &llow Finger Print Ervoliment [~ Create
— antender [ Order Type Promize Time Adjust [~ Edit
n 202 Bartender- M5R Req ™ Repotting
n 203 Bartender- Req Finger Print [~ Setle
301 QSR Cashier 1
: 302 | QSF Drive Thiu D atabasze Manager Tranzaction Analyzer
303 | Q5R Cashier 2 [~ Allow DB Rebuid I"" Use Transaction Analyzer
B 304 Q5R nonCOM I~ Allow Encryption Key Change =
B 401 | Delivery Cashier [~ Allow DB Backup r
— 402 D [~ Allow DB Restore
- et ™ Allow User Edit mT ablet Configuration
— 501 |Retail Cashier [T Allow Security Log Access [ Associate mT ablet with mStation
B0 |API Emplopes [ Allow DB Utilties [ Dizassociate mTablet from mStation
n 9999k anager
10000 CHautoclose il
Tl bl oo 04904 C AN AN Ak

Interfaces

To access interfaces, select Poscfg > Devices > Interfaces.

=
Fle Edt Record Help
Interfaces O R £ 52
7 Chip & PIN Interiace StBy [Nucer =] |4 4 B Mo = dpem Qj@
 Record View | Table View|
Hurmber | Name Jal  Genesal | inteiface |
1 0CB
| | 2 SiM Dutpoing Massage Name Timacat
. 3|ddd [Chip & P [ 12
4 PMS

Mebeork Mode Hurmbes |0 Dagis
Ig vI

[ Log Trarsachons
[ SIM Irderface

Irtesface Typa
TCP b

Ackmorustrator, The /2205 E41.15 AM 4

Use the following parameters:

*  Number:7

ORACLE ot
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* System Name: Chip&PIN Interface

* QOutgoing Message Name: Chip&PIN
* Timeout: 120

* Network Node: RES Server

*  Number ID Digits: 9

* SIM Interface: enable

° Type: TCP

ISL Files import

Chapter 2
OGDH OPI Solution

RES 5.6 and above releases improves security for importing and running Interface
Scripting Language (ISL) scripts. If you use this version of RES, you have to use the ISL
Files menu in the POS Configurator to add or update .ISL files, such as PMS.isl, OPl.inc

and MGDH.tra.
To access ISL Files, select POSCFG > Devices > ISL Files.

Click Auto Load ALL ISL Files button, the POS configurator will import ISL Files from

default path \MICROS\Res\Pos\Etc\

[ 1SL Files

File Edit Record Help

ISL Files =B R E Dy i @ R?
SortBy |Number ~| |4 4 p p| ¢7 S + ) 4.,

Record View l Table View l

Number Name »  General |

=% HoR =)

12 |
‘Woarking Directory

= &uto Load &Il 1SL Files

[ Dir
|

File Name

[ =]

Preview

<

To update .ISL files, select the ISL menu file and then click the Browse button to select

the .ISL file.

# NOTE:

Please restart OPS after you import or update files.
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Touch Screens
To access touch screens, select POSCFG > Devices > Touchscreen Designer.
Category: SIM/PMS Inquire
Interface: Select the interface that we created
Link touchscreen keys to the correct SIM inquire # using the values below.
Following are the buttons for TSR:
*  [Sale + Tip]: SIM INQ #2
(Supports tipping from the PED. Configure INQ #2 instead of INQ #1. For TSR only.)
° [Tip Adjust]: SIM INQ #3
* [CC Refund]: SIM INQ #4 (Recommended refund method.)
¢ [Refund(m)]: SIM INQ #11
¢ [CC Auth]: SIM INQ #8
e [CC Final]: SIM INQ #9
e [Tab Auth]: SIM INQ #13
° [Balance Inq]: SIM INQ #16
° [Reprint]: SIM INQ #7
* [Repost]: SIM INQ #19
*  [Void(e)]: SIM INQ #17
° [Manual Auth]: SIM INQ #18
*  [Auth + CNP]: SIM INQ #14
* [GC Function]: SIM INQ #10 (New for RES in OPI 6.2)

# NOTE:

[Void(e)] INQ #17 is a special button. It exists on POS 3700 only. For other
POS platforms, it is not needed.

Following are the buttons for QSR:

+ [CC Sale]: SIM INQ #1

* [SALE&CASH]: SIM INQ #5

* [CC Refund]: SIM INQ #4 (Recommended refund method.)
* [Refund(m)]: SIM INQ #11

* [Balance Ing]: SIM INQ #16

* [Reprint]: SIM INQ #7

° [Repost]: SIM INQ #19
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° [Void(e)]: SIM INQ #17
° [Sale + CNP]: SIM INQ #6
* [GC Function]: SIM INQ #10

# NOTE:

[Void(e)] is a special button. It exists on POS 3700 only. For other POS
platforms, it is not needed. All void buttons need to be replaced with it.

Tender Media

Setup the following for credit cards.

=1
File Edt FRecord Help
0 by -2 by -
Tender [ Media SRl AR R # @ N2
‘201 Viza Sart By INumber "I M 4 » M7 T @
Recard Yigw | Table Viewl
General  Tender |Presets| CC Tenderl Credit .&uthl PS5 I Service TTLI Prir 4 I 'I
MNurnber | M arne |;| General Options Charged Tip
|| 101 Cash [~ Open draver Igm Charge Tip j EI
|| 102 Traveler Chi, [~ Use with curnency conversion High Amount Lockout
102 | Personal Chi v Reference required £
| 104 GC Bedesm [~ Exempt auto service charge I Enable HALD
| 105 SVEC Redeem M Eplareires I
— v Azzume paid in full
- 106 5WC [~ Require amaunt entry £ HALD limits overtender
| 200 - CreditCard _I ™ Declare tips paid % Hel0 limits amount tendered
W\ﬁsa [¥ ltem iz shareable Options
|| 202 MasterCard [V Post to gross receipts [~ Enable Tender Rounding
203 Amex [v Post to charge receipts [ | Bound Tender ta Nearest 10
204 Dirers [~ Post fiscal cash register credit I~ Rounding Based an Tiens Digtt
B 205 | ICE [~ Tax E”E_”"F't Coupan | meigniticant Digits
— [ Allow with Evro 0 =
| 206|30L0 [~ Use with Tip Check
| 207 Laszer External Type
[ | Administrator, The | 11A19/2015 43651 &M
# NOTE:

*  Assume paid in full.
* Reference required.
* Charged Tip: Set to 0 None if all RVCs are QSR mode.

* Charged Tip: Setto Link a Tip service charge if some RVCs are TSR
mode.
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The following Tender / Media tabs should be left blank (no options enabled):
* Presets

* CC Tender

*  Credit Auth | Authorization

*  Credit Auth | Preambles

On the PMS tab, enable Allow 19 reference characters.

Ei Tender / Media =10l x|
File Edit Record Help

Tender / Media B n b i = O oy #h &2
|2l]1 Viza Sort By INumber M4 ES g = @

Record Wiew | T able Wiew I

Generall Tenderl F'resetsl CC Tenderl Credit Auth  PMS |Service TTLI Prir A I ’I

Mumber | Mame I;I

101 | Cash Property Management System

102 Traveler Chi

B 103 Parsonal Chi [~ Paost 0.00 amounts to PMS

W 104 G Redeem [~ Danat post reference entry
W 105 5YC Radeam [~ Past grass repts b PMS
W 106 ST [~ Print both the posting message and the resporise
W 200 - CraditCard [~ Donot zave PMS response
MM_I [¥ &llowe 19 reference characters
| 202 MaszterCard Property Management Interface
n 202 Amex I j EI
| 204 Diners
| 205 JCB
| 206 50LO
207 Lazer

=

[ | Administrator, The [ 1119/2m5 437308

Cash Back Tender

Verify whether the Merchant wants cash back functionality before configuring this.

ORACLE g
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Tender/ Media
File Edit Record Help
Tender / Media BT HABRCE > # @ N?
216 CashBack Tdr SotBy [Number ~| |4 4 b M = al
Record View ] Table View]
General Tender | Presets] CC Tender | Credit Auth | PRS | Service TTL.| Printing | Perzonal Cl
Mumber | Mame | - General Options Charged Tip
L 211 Ol Visa [~ Open drawer - g
212 0P Discaver ™ Use with currency conversion .
— . High Amount Lockout
213 0P Amex [+ Reference required e
N 214 0P| Diners [ Exempt auto service charge [ Enable
W 215 OFI M.C [~ Exempt inclusive service charge
~ 18 - [~ Employee meal
— v Azzume paid in full ?
- 220 ™ Require amount entry
n 300 - Other [~ Declare tips paid Options
n 3 Manager Meal v Item iz shareable [~ Enable Tender Truncation
A 302 Promo v Pastto gross 'ECEiD_tS [~ Enable Tender Rounding
N 400 - Foam Chrg v Post tp charge rec:e.lpts . r
401 Room Charge ™ Post fizcal cash register credit r
— [~ Tax exempt coupan
L 402 | Azcount Chrg w
| | 501 Cash Drop [~ Use with Tip Check 0 -l
n 502 Cash Pickup [~ Check for Placehalders Extemal Typs
a 503 Tips Paid ™ Persizt Auto Dizcounts i
i B04 | Paid In F Eromp‘tjfor F'ro;nirse Time SR Payment Tope
505 Paid Out pen drawer befare prampt
: 900 - Semvice I~ Enforce beverage control
n 901 Service
a 902 | Print Check.
Cash back is supported for QSR revenue centers only.
Sales | Tender / Media | Tender:
*  Assume paid in full.
* Reference required.
* Charged Tip - 0 None.
Tender_-'Media
File Edit Record Help
Tender { Media HEAHABEDR > o @ n?

216 CashBack Tdr

Record View l Table Yiew ]

Number | Name ‘ -

211 0PI Yisa
212 0PI Discover
213 0PI Amex
214 0PI Diners
215 0PI M.C.

300 - Other

307 | Manager Meal
302 | Proma

400 - Foom Chrg
401 | Room Charge
402 Account Chrg
B01 | Cazh Drap
502 Cash Pickup
503 Tips Paid
504 Paid In

505 Paid Out

900 - Service

907 | Service

02| Print Check

g2

Sort By [Mumber =

LI I

* = =1k

"General | Tender | Fresets CC Tender ‘ CreditAuth | PMS | Service TTL | Frinting | Personal |

Credit Cards Frompt for ...

[T Werify before authorization [~ Prompt for immediate payment

[ Tender must exceed tip [~ Prompt for izsue number

[~ Credit auth required [~ Prompt for izsue date

[ Credit final amount required [~ Prompt for optional trailer print

[ Allow recal [v Prompt for cashback amaont

™ Mask Credit Card Mumber [~ Prompt for Card Holder Mot Present
[T Mask Cardholder Mame [~ Prompt for C¥% on Marnual Entry
[ Persistent Payment [~ Prompt for CVA on Swiped Entry
Iv Debit Card [~ Do not Prompt for A%S

[~ &llow debit refund
[~ Co-branded Credit Card

Expiration D ate

FINPad
[~ Expiration date required [~ Fequire PIN
[~ Do not check expiration Account Input
I~ Open expiration fomat Prompt Length
1]

[~ Mask expiration date
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Debit Card.

Prompt for Cashback Amount.

Tender_a'Media

File Edit Record Help

Tender { Media

216 CashBack Tdr

RETHRE 2
4 4 » M g =

i € N2
SortBy |Mumber = @

Fecord Wiew ] T able View ]

-Generall Tender] F'resets] CC Tender] Credit suth  PMS | Service TTL.| Frinting | Personal [

MHurnber | M ame | -
211 0P Viza

212 0P Discover
o [ Post 0.00 amounts ta PMS

213 0P Ames
214 0P Diners [ Do not post reference entry

Froperty Management System

| 0P| M.C. [ Post grozs ropts to PRS

| 215
» 216 8
i 220
300 - Other
301 Manager Meal Property Management Interface
| 302 | Prama |

400 - Roaom Chrg

401 Room Charge

402 Account Chrg

501 Cash Drop

502 Cazh Pickup

503 | Tips Paid

504 Paid In

505 | Paid Out

900 - Service

am
q02

[ Print both the posting mezzage and the responzse

[~ Donat zave PMS response
[v allove 19 reference characters

| [

Service
Pritit Chieck

Allow 19 reference characters.
OPl.inc must have this value:

Promptcashback = True

Cash Back Service Charge

The cash back tender also requires a cash back service charge, though it is not directly
linked to the cash back tender.
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Service Charges

File Edit Record Help

Service Charges

[(==]=]

BoRTHE > M @ K2

| 905 CashBack SVC

SotBy [Number ~| |4 4 b M 7 ) o == a&

Record View | T able Yiew I

Mumber | Warne

I F

901 Charge Tip
902 18% Grat.
903 Driver

n 904 | Delivery chg
Ld 305 {eE 5
906 | GC Cashout

General I Dptionsl Service Ehargel

Taw Class SLU

I LI QI I j QI leon
Frivt Clazz Merw Level Class

|101 GuestCheck  ~| | |101 AllLevels R =

Frivilege HLU Amount tlinimumm Amount b asimum Amount
o = | | | |
Category Key Code Percent Fimimumm Percent M aximum Percent
= | | | |

Effective From

I |

Effective Tao

I, |

Congalidation Group

| TheManager, Joe | 914201611:38208M 2

Setup the following service charges.

* Name = “CashBack SVC”

* Onthe General tab, select the Menu Level Class = All Levels and Print Class =
Guest check from the drop-down list:

ORACLE
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Service Charges
File Edit Record Help

Service Charges
905 CazshBack 5¥C

Record Yiew ] Table Wiew ]

Mumber | M ame: | -
901 Charge Tip
902 15% Grat.
903 Drriver

n 904 Delivery chg

4 CashB

B 90 | GC Cashout

o c

A @
SortBy [Mumber  ~| |4 4 » Pl = a’;""'

"General Options | Service Charge ]

i
9

p

oy T

General Settings Apply ta Service Charge Itemizer
[~ Preset v ltemizer 1
v Amount v ltemizer 2
[~ Reference required Iv Itemizer 3
[~ Print walidation v ltemizer 4
v Fieset itemizers v ltemizer 5
[ ltem is shareable v ltemizer B
[ Cazh Management Till Required v Itemizer ¥
[~ Print Multiple Checks/Receipts Iv ltemizer 8
-

Euternal Cross Reference 1 Euternal Type

E=ternal Cross Referance 2

=

(B3

The Manager, Joe

9/14/2016 11:38:53 &M

On the Options tab, select Amount and Reset itemizers check boxes.
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E= Service Charges ===
File Edit Record Help
Service Charges & T £ 2 #Hh & r?
905 CashBack S¥C SortBy [Mumber  ~| |4 4 B B = = F 1
Frecard Yiew ] Table \-"iew]
I || Opti Service Charge |
Mumber | Mame | - L I [ |
901 Ch Ti
- A 15;:;;&.”3 Type B F'c-&tap,ar-:entlage to tips paid
1 903 Driver " Standard [~ Post totips paid batal
| 304 Delivery chg " Mon-Revenue :: Eo&l tct' -:hatr?ed llpst.toltalt |
= s = 0 not post ko emp tip totals
Ld LY EashBack SWE {* Mon-Fevenue Cash Back
906 | GC Cashout
B [ Post to cover count TenderMedia for Tips Paid
[ Post to sve charges total | ﬂ g
The Manager, Joe 942016113922 Ak

On the Service Charge tab, select Non-Revenue Cash Back option.

POSEQOD

To verify POSEQD files are properly configured, go to
Micros\Res\Pos\Scripts\poseod\ and verify the contents of the following files:

ORACLE

MGDH.inc

Verify the server IP address and port are correct for the computer that hosts OPI.
POSEOD.inc

Verify OR is the code for RES 3700. Other POS types use a different code.

Verify the Merchant ID is correct. The following example shows a merchant ID and
code. Separate multiple merchant IDs with the pipe symbol and no spaces (for
example, |0OR|3700000001[3700000021).

| POSEOD.inc - Notepad
File Edit Format View Help
|OR | 3700000001 |

To run POSEOD manually, double-click the
Micros\Res\Pos\Scripts\poseod\poseod.exe file.
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A DOS CMD window flashes briefly.

To verify POSEOD ran successfully, open the
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OraclePaymentInterface\log\transaction.log file and confirm BATCH and
APPROVAL appear with the correct time stamp at the bottom of the file.

BATCH 00 APPROVAL
MEM R34 00 AFFROVED
MGEM R34 00 AFFROVED
MEM R34 00 AFFROVED

Configuring POSEOD to run as part of a scheduled RES autosequence:

Autosequences

External Programs

File Edit Record Help

External Programs
916 POSEOD

Recaord View ] T able View ]

Sort By |Mumber =

Murmber | I arne | -
907 KDS

908 Denizeexport

903 CMautoclose

910 Alert Wiewer

911 CMD

2 Report Viewer Default

113 Report Viewer WIEWER

914 ALERT WIEWER

15 Product Mor Procedures

G FosEOD

Working Directory

-

(o= |[=]
BWHABRE > ¢ &2
14 4 = =]
POSEOD
User Interface
|D:unso|e ﬂ
Fiun Style
|N0rmal j

[ Showe Alert Status
[ Run in zeparate wirtual machine

Object Range Type

| =l

Dir |$[MIEF|DS_DIH_PDS]‘\ScriptS\F’oseud J
Command Line
Diir |$[MIEF!DS_DIH_PEIS]\Scripts\Poseud\Poseud.e:-:e J

1. Poscfg | System | External Programs
* New record named: POSEOD
* User Interface: Console

° Run Style: Normal

*  Working directory: $(MICROS_DIR_POS)\Scripts\Poseod

* Command line: $(MICROS_DIR_POS)\Scripts\Poseod\Poseod.exe

2. Call the above external program during the End of Night autosequence, but before
printing occurs. (So that if printing fails, it will not prevent POSEOD from running.)
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# NOTE:
You can schedule POSEOD using Windows Task Scheduler.

Tax Type Settings in OGDH

Verify your RES database tax types match what OGDH is set to.
Percent and Breakpoint taxes are sent as part of the <TaxAmount> to OPI.
Inclusive and Full inclusive tax amounts are not sent to OPI and this is by design.

But if a percent or breakpoint tax is assumed by OGDH to be inclusive, that tax amount
will not be included in the <TaxAmount> sent to OPI.

There is no visible “TaxType” entry in OPL.inc, but the default taxtype setting is as follows.
TaxType = "PIPIIPPP"

The above default setting assumes in Poscfg | Sales | Tax Rates | General that:
Tax 1 = P = Type (percent or breakpoint)

Tax 2 = | = Type (inclusive or Full inclusive)

Tax 3 = P = Type (percent or breakpoint)

Tax 4 = | = Type (inclusive or Full inclusive)

Tax 5 = | = Type (inclusive or Full inclusive)

Tax 6 = P = Type (percent or breakpoint)

Tax 7 = P = Type (percent or breakpoint)

Tax 8 = P = Type (percent or breakpoint)

If the tax rates being used by the RES database do not match the types listed above, you
can correct that by either:

1) Moving tax rates in RES to match the OGDH defaults.
Or

2) Add a line to OPl.inc that tells OGDH your actual tax types.
Ex: If your tax types are:

Tax 1 = percent

Tax 2 = breakpoint

Tax 3 = inclusive

Tax 4 = full inclusive

Tax 5 thru 8 unused

Add this line to OPLl.inc:

TaxType = "PPIIPPPP"
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The "quotes" shown above are necessary.

ORACLE 517



OPI Installation

Uninstalling the Old Version of OPl and MPG

Upgrading from OPI version 6.1 and later to OPI 19.1 is supported.

Upgrading anything earlier than OPI 6.1 is not supported. Remove earlier versions of the
software before installing OPI 6.2.

To Uninstall

1. Run POSEOD with the old version to verify all previous transactions have been
batched. Verify the batch was approved in the transaction.log.

2. Save a backup of the current OPl and MPG folder structure.

3. Openthe $OPI HOME%/bin/MicrosGatewayConfig.exe file and save a screen
capture of the ServerXX values.

4. Save a screen shot of the POS record you are using and its values (for example,
posResl).

5. Uninstall these components through Microsoft Programs and Features:

*  MPG

* MySQL if no other products are using it

°  MySQL community

6. Rename the C:\ProgrambData\MySQL folder to MySQL Old.

7. If you do not see the C: \ProgrambData folder, enable Windows Explorer > Tools >
Folder Options > View > Show hidden files, folders, and drives, and then close and
re-open Windows Explorer.

8. Restart the computer.

9. Install OPI.

Installing the OPI

ORACLE

Take Micros Control Panel to off.

Copy OraclePaymentInterfaceInstaller 19.1.0.0.exe tothe Server and
double-click it to launch the install.

Select your language, and then click OK.

Click Next on the Welcome to the InstallShield Wizard for Oracle Payment Interface
screen.
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5. Click Next on the OPI Prerequisites screen.

- .

L4t

(") Custom
-

Setup Type
Select the setup type to install.

(@ Complete

Oracle Payment Interface - InstallShield Wizard @

- ,

Please select a setup type.

All program features will be installed. (Requires the most disk space.)

Select which program features you want installed. Recommended for
advanced users,

< Back ][ Mext = ][ Cancel

The Setup Type screen appears.

* Complete: All program features will be installed.

* Custom: Select which program features you want installed. Recommended for
advanced users only.

6. Make a selection, and then click Next.
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Oracle Payment Interface - InstallShield Wizard C |

Select Features
Select the features setup wil install,

-

Select the features you want to install, and deselect the features you do not want to install.

escription
Pl Database Schema Descript
.[¥]OPI Services Sets up the E;:zﬁﬂt:ass b
[T configuration Toal components for the define
onfiguration Tool chema.
157.84 ME of space required on the C drive
435653, 20 MB of space available on the C drive
< Back ][ Mext = ] [ Cancel

If you select the Custom install option, the Select Features screen appears with the
following options:

a. Database Schema
b. OPI Services
c. Configuration Tool

All these three features must be installed. It is just a matter of whether they are all
installed on the same computer or on separate computers.

7. Select the features to install on this computer, and then click Next.
The Choose Destination Location screen appears.

8. Accept the default installation location or click Change... to choose a different
location, and then click Next.

9. Click Install on the Ready to Install the Program screen. The Setup Status screen
displays for a few minutes.

The Setup Type screen appears.

ORACLE 33



Chapter 3
OPI Installation

Oracle Payment Interface - InstallShield Wizard ]

Setup Type
Select the setup type that best suits your needs.

Select Database being used.

@ MysQL
(71 501 Server
() S0L Express

(") Orade DB

< Back Mext = ] [ Cancel

10. Select the database type that is currently used, and then click Next.

# NOTE:

OPI does not install any database, so the database must already be installed.

Oracle Payment Interface - InstallShield Wizard @
Database Server

Enter the Database Server Mame or IP.
Enter the Port Mumber.

MameIP:

Port #: 3306

< Back ][ Mext = J[ Cancel
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The Database Server screen appears.

11. The Name/IP: field defaults to localhost. This should be left as localhost if the OPI
database is installed on the same computer. If the database is installed on another
computer, the Name or IP address of that machine should be entered here.

# NOTE:

If the database type is MySQL, and you cannot use localhost for the Name/IP
field, then some commands must be run manually on that MySQL database
before proceeding. See the Granting Permission in MYSQL section in the
Oracle Payment Interface Installation and Reference Guide for instructions.
Setup will not complete if this is not done.

12. Accept the default Port # of 3306 (for MySQL), and then click Next.
The Database Server Login screen appears.

Oracle Payment Interface - InstallShield Wizard

Database Server Login
Database server reguires login credentials to continue.

DBA User

Login ID:

Password:

13. Enter the server login credentials of DBA user for the database type selected, and
then click Next.

*  For MySQL the Login ID: = root
* For other database types the DBA user name/Login ID may be different.
* Enter the correct password for the DBA user.

The Database User Credentials screen appears.
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-

Oracle Payment Interface - InstallShield Wizard @

14.
15.

16.
17.
18.

Database User Credentials

~ ,

Enter the user name and passwaord to create a new database user account that will be used
by the Orade Payment Interface application.

Password is case sensitive, should be at least 8 characters in length and must have at least
one upper case letter, one lower case letter, one number and one spedial character from the
following list: | @#£5%~&™

User Name:

Password:

Confirm Password:

< Back ][ Mext = ][ Cancel

User Name: Enter the user name to create a new database user account.

Password: Create a password. Password is case sensitive, should be at least 8
characters in length and must have at least one upper case letter, one lower case
letter, one number and one special character from the following list: !@#$%"&*..

Confirm Password: Confirm the new password, and then click Next.
Click OK on the Database connection successful dialog.
Click OK on the Database Configuration operation successful dialog.

The Configuration Tool Superuser Credentials screen appears.
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Oracle Payment Interface - InstallShield Wizard [ =2 |

19.

20.

21.
22.

Configuration Tool Superuser Credentials

a

Enter the user name and password to create the super user account for the configuration
tool,

Password is case sensitive, should be at least & characters in length and must have at least
one upper case letter, one lower case letter, one number and one spedial character from the
following list; | @#5% &=

User Mame:

Password:

Confirm Password:

< Badk Mext = ] [ Cancel

User Name: Enter the user name to create the Super user account. This can be any
user name and does not have to be a Windows account user.

Password: Create a password. Password is case sensitive, should be at least 8
characters in length and must have at least one upper case letter, one lower case
letter, one number and one special character from the following list: |@#$%"&*.

Confirm Password: Confirm the new password, and then click Next.
Click OK on the Create SuperUser operation successful dialog.

The Configuration Tool Connection Settings screen appears.
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Oracle Payment Interface - InstallShield Wizard \&_\

23.

Configuration Tool Connection Settings

Please enter the Configuration Server Connection Information:
(ex. Host: Port: 8090 / Host: Port: 8090 )

Host: Port: 8090

[ < Back ][ Next > ][ Cancel ]

Host: Enter the IP address or server name of the PC where the OPI Config Service is
installed. This will be the PC where you selected “OPI Services” to be installed.

Leave the default Port of 8090.
Click Next.

The Configuration Tool Passphrase screen appears.

Oracle Payment Interface - InstallShield Wizard

Configuration Tool Passphrase

-

Please enter the Configuration Tool Passphrase.

Passphrase is case sensitive, should be at least 15 characters in length and must have at
least one upper case letter, one lower case letter, one number and one spedal character
from the following list: | @#8% " &*

Passphrase:

Confirm Passphrase:

l < Back ][ Mext = ]’ Cancel ]

24.

25

Passphrase: The passphrase is case sensitive, should be at least 15 characters in
length and must have at least one upper case letter, one lower case letter, one
number and one special character from the following list: '@#$%"&*.

. Enter a passphrase, confirm it, and then click Next.
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After a brief pause, the Configuration Wizard launches.

% Oracle Payment Interface - Configuration Wizard = | 3] “@

Oracle Payment Interface — Configuration Wizard

Please select the OPI instance mode:

v/| POS
Native Driver
(®) OGDH

PMS

ORACI—E‘ Next Close
HOSPITALITY

26. Select POS and OGDH, and then click Next.
The POS OGDH Configuration screen appears.

27. Enter and confirm the Passphrase, and then click Next. Passphrase must be at least
15 characters in length and include at least one uppercase letter, one lower case
letter, one number and one special character from the following list: !|@#$%"&*.

The OPI Interface screen appears.

@ Oracle Payment Interface v6.2 - Configuration Wizard (=@ ]Ej‘

Oracle Payment Interface — Configuration Wizard

OPI Interfaces

PMS .

POS m ' POS Service Port: 5098

OPI to PSP Communication Configuration:

OFI Mode: Middleware = Enable Mutual Authentication
Private Key Cert, Password: Confirm Password:
Root Certificate Password: Confirm Password:
Primary Host: https://192.0.2.1:443 Proxy Host:
Failover Host: https/pspsfailoverhostd Proxy Port:
ORACLE‘ Next Close

HOSPITALITY

28. Enable Mutual Authentication: Enable this option only if the PSP has provided the
certificates and passwords for it.
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29. Private Key Cert. Password: Enter the password and confirm it.
30. Root Certificate Password: Enter the password and confirm it.
31. Select the OPI Mode either as Middleware or Terminal.

* Middleware: Fill in the primary host connection information and the failover Host
information (if provided).

° Terminal: Select correct Port. If using Mutual Authentication, see the Mutual
Authentication section in the Oracle Payment Interface Installation and Reference
Guide.

32. Click Next.

33. Click the blue + icon in top right corner to create new merchant record.

34. Select the POS Type as RES.

35. Select the Merchant Type as Restaurant or Retail.

36. Enter the Merchant ID.

37. Enter the Merchant Name, Merchant City, Merchant State or Province.

38. Select the Merchant Country/Region from the drop-down list.

39. Select the Enable Pay at Table check box if the merchant will use Pay at Table.
40. Click Next.

Pay at Table Install

# NOTE:

If not using Pay at Table, scroll down to the end of the Pay at Table section to
the Merchant Terminal Configuration screen.

41. Complete or accept the following default values for Pay at Table fields:

* DB Host: Canremain 192.0.2.1 if OPI is installed on the RES server. Otherwise,
enter the IP address of the RES server.

* DB Port: Leave at 2638.
* DB Name: Leave at Micros.
* DB User: Enter a user name that can access the RES database, and confirm it.

° DB Password: Enter the password for the DB user entered in the above step while
installing OPI and confirm it.

° Tenders: If the Pay at Table tenders are not already configured in POSCFG, go to
the Pay at Table Tender Config section and do that now.

* Enter the correct Tender number for each card type used with Pay At Table.
*  Print Check: Enter the number of the Print check tender.
* Service Charge: Enter the number of the Service Charge that is used for tips.

42. Click Next.
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43.

44.

45.

46.

47.

48.

49.
50.

51.

The Pay at Table Devices screen appears.

Click the blue + icon to add a Pay at Table device, and then configure each device to
query by either check number or table number.

Click Next.

The Pay at Table Configuration screen appears.

Complete or accept the following default values for Pay at Table Configuration fields:
Service Port: Enter the correct port for use with Pay at Table terminals.

Certificate Password: If doing a new OPI installation, then use the certificate
password and port provided by the PSP.

Click Next. This will end the Pay at Table Install section here.

If using Terminal mode, the Merchant Terminal Configuration screen appears. If
using Middleware mode, this screen will not appear.

Complete the following Merchant Terminal Configuration fields:
Workstation ID: Enter the workstation number from the POS system.
Terminal IP: Enter the IP address of the pinpad device.

Click Next.

The POS Merchants screen appears.

Click the wrench icon to edit an existing merchant record.

Click Main to go back and review settings.

Click Close to advance to final screen.

Oracle Payment Interface - InstallShield Wizard

ﬂ Installshield Wizard Complete

=

The Installshield Wizard has successfully installed Orade
Payment Interface, Before you can use the program, you
must restart your computer.

(@ Yes, I want to restart my computer now.,
() Mo, T will restart my computer later,

Remave any disks from their drives, and then dick Finish to
complete setup,

< Back Cancel

ORACLE
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52. Click Finish to reboot.

If a reboot cannot be done at the moment, you must stop and then start the OPI
Service for current settings to take effect.
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Upgrading MGDH to OGDH

ORACLE

Before upgrading

* Run Poseod.exe to settle all credit transactions.

Steps to upgrade from MGDH 6.1 or higher to OGDH 19.1.0.0
1. Take Micros Control Panel to off.

2. Double-click OGDH 0PI 19.1.0.0.exe tolaunch the install.
3. Click Next on the Welcome screen.

OGDH Installer =

Uparade files

The files listed below will be updated during the upgrade process. Please make sure that the
information in these configuration files is accurate for your environment, if not, please cancel
the current installation and try again once the files have been verified or corrected.

Cy\MGDHDriver \OPI_3700_5.4.0100. 2276 \server \etc\MGDH.inc e
C:\MGDHDriver\OPI_3700_5.4.0100. 2276 \server \etc\OPLinc

C:\MGDHDriver \OPI_3700_5.4.0100. 2276 \server \poseod \MGDH. inc

Cy\MGDHDriver \OPI_3700_5.4.0100. 2276 \server \poseod \POSECD.inc

< Back [ Mext = ][ Cancel

IMPORTANT: If the above files do not currently have the correct settings, those same
settings will exist in the new OGDH files. Please verify those specific files in those
locations are correct before continuing.

# NOTE:

If POS upgrade causes part of OGDH installed files on win32 workstation
client to be lost, go to the OGDH32 CAL package and edit the setup.dat to
increment the version #. For example: Change 6.2.0.7 to 6.2.0.8. This causes
the package to re-install automatically to workstations
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4. After verifying the files are correct, click Next.
Question dialog:

“In order to connect to Sybase the Sybase driver will be required. The following
dialog will request the path for the Sybase driver. Continue?”

5. Click No.

6. Either accept the default install location, or click Change to choose a new location,
and then click Next.

7. On the Ready to Install the OGDH screen, click Install.

The InstallShield Wizard screen appears.

:

OGDOH Installer
Setup Status

The Installshield Wizard is instaling OGDH

MGDH OPI Selution package Uninstall EX

| Are you sure you want to completely remove MGDH OPI Sclution
' package and all of its components?

ves || N

Cancel

8. Click Yes. The MGDH files will be uninstalled and the OGDH files are installed.
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51 0GDH Installer e @ =]

Connect to RES database
This connection will be used to retrieve details like RVC list, Tender Mappings, etc.

DB System @ Sybase
Haost / IP Address
Port | 2638
DB Mame / SID
Username
Password

Connect Skip DB Connection

Close

ORACLE
HOSPITALITY

9. Click Skip DB Connection.
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11.
12.
13.
14.
15.

16.
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7| OGDH Installer =l @ =]

Tender mapping configuration

Please configure tender media mapping details.

WeChat Pay -
AliPay -

GC Cash-out SVC -

Back Next Close

ORACLE’
HOSPITALITY

WeChat Pay, AliPay and GC Cash-out SVC fields are new in this version of OGDH.
In Micros control panel take Restaurant to Database level.
Open POSCFG | Sales | Tender/Media to see tender information.

Enter the correct tender number for each tender. Leave unused tenders blank.

For GC Cash-out SVC go to POSCFG | Sales | Service Charges.
Click Next.
On Tender Mapping configuration screen, verify settings are correct, and then click

Next.
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5 | OGDH Installer = B |5

Extra Tender mapping configuration

Please configure tender media mapping details.

Enable extra tenders

ExtraTenderl - ExtraTenderl3 b
ExtraTender2 - ExtraTenderld -
ExtraTender3 - ExtraTenderl3 -
ExtraTenderd -
ExtraTender5 -
ExtraTenderf -
ExtraTender? -
ExtraTenderg -
ExtraTenderd -
ExtraTenderl0 -
ExtraTenderll b
ExtraTenderl2 -

Back Close

ORACLE
HOSPITALITY

# NOTE:

Note that all tenders that existed in the previous MGDH installation have
already been transferred to new OGDH OPIl.inc file.

17. If you have any Extra tenders you may enter them here. You must first select the
Enable extra tenders check box.

18. Click Next.

19. Verify extra tender settings are correct, and then click Next.

20. For RES only, the “Event 17 do Void” must be enabled.

21. Set the other values correctly.

22. “Use GC denominated value” means they sell gift cards that have a set price.

Leave this disabled if gift cards are sold as an open amount that the operator types
in.
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"] OGDH Installer =] @ =]

Transaction configuration details

Please configure transaction level options.

Gift Card Support - GC activation menu item

Use GC denominated value Dizabled GC top-up menu item
Back Close
HOSPITALITY

23. The values above are new in this OGDH version. Set them correctly for your system.
24. Click Next.

25. Verify settings are correct, and then click Next.

26. On the Configuration Complete screen, click Save.

27. On the Install Wizard Complete screen click Finish.

Upgrading the OPI

VERY IMPORTANT: Read and follow the upgrade directions.

# NOTE:
OPI 6.1 and higher can be upgraded to OPI 19.1.

OPI Upgrade Steps

1. Right-click and Run as Administrator the
OraclePaymentInterfaceInstaller 19.1.0.0.exe file to perform an
upgrade.
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5.

OPI Prerequisites

Chapter 4
OPI Upgrade Install
Select a language from the drop-down list, and then click OK.
Click Next on the Welcome screen to proceed with the installation.

Prerequisites for the installation will be checked, including the required free drive
space, details of the host environment, and the Java version that is present.

Click Next on the OPI Prerequisites screen.

Following is some information related to your system:

Yurrent Date & Time 24-01-2018 16:00:26 -
Free space on drive C: 43805 MB

Free space on drive D: 24797 MB

Extended memory: 4193848 K

Selected Language: English/1033.

Computer default language: English/1033.

This is a 64 bit Operating System.

OS version Windows 7 Professional Service Pack 1

OS version 6.1

Found Java version JRE 1.8

Found Java Home C:\Program Files\Java\jre1.8.0_144
A version of OPI has been found.6. 1 -

£ »

m

Click OK on the OPI Upgrade screen.

OPI Upgrade

A6.1 version of OPI has been detected. The installer will have to perform a
complete uninstall of 6.1 before upgrading to 19.1. The next message will ask if
you want to completely remove OPI and all of its components. Click Yes to the
next message to upgrade OPIto 19.1.

[ OK ] [ Cancel

WARNING! You must click Yes.

IF YOU CLICK NO, YOU WILL HAVE BOTH OPI 6.1 AND OPI 19.1 INSTALLED
AND NEITHER WILL WORK.

Explanation: OPI will migrate the existing MySQL configuration information, but all
previous OPI applications will be removed before the new files are installed.

Choose a Destination Location. Accept the default installation location or click
Change... to choose a different location.

Click Next.
The Ready to Install the Program screen displays.

Click Install.
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The Setup Status screen displays for a few minutes.
Setup Type
For database type, select MySQL. No other database type is supported for upgrades.
Database Server

Name/IP: The Hostname or IP Address used for communication to the MySQL
database. This must be left at the default of localhost.

Port #: The Port number used for communication to the database
Database Server Login

DBA user

Login ID: root

Password: root user password for MySQL database.
Database User Credentials

User Name: This must be a new user name. It cannot be the same user from the 6.1
install.

Password: Password for the new database user.
Configuration Tool Superuser Credentials

User Name: This can be any user name. It does not have to be a Windows account
user.

Password: Create a password, and then confirm it.
Configuration Tool Connection Settings

Host: Enter the IP address or server name of the PC where the OPI Config Service is
installed. This will be the PC where you selected “OPI Services” to be installed.

Port: Leave at 8090.
Configuration Tool Passphrase
Enter and confirm a passphrase.
Click Next.
The Configuration Wizard launches.
Continue to follow on-screen directions, verifying settings as you go.
POS Merchants
On the Merchants screen, click the wrench icon to the right of the existing merchant.
Verify the merchant settings are correct.
Merchant Pay At Table Configuration

If using Pay at Table, review the tender settings carefully as there are new fields that
will not be pre-populated from the previous OPI install.

Continue to follow the on-screen directions.

InstallShield Wizard Complete
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Click Finish to allow a reboot.

Oracle Payment Interface - InstallShield Wizard i

AA InstallShield Wizard Complete

R

The InstallShield Wizard has successfully installed Oracle
Payment Interface. Before you can use the program, you
must restart your computer,

« Yes, I want to restart my computer now.
" No, I will restart my computer later,

Remove any disks from their drives, and then click Finish to
complete setup.

< Back I Finish I Gancel
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All OPI utilities and instructions for using them are covered in the OPI Installation and
Reference Guide.

Q: How do | update the OPI DB user password?

A
1.
2.

: First change the pw in MySQL.

Stop OPI service.

Start | All programs | MySQL | MySQL Server 5.7 | MySQL 5.7 Command line
Client.

Enter the MySQL root user account pw at the prompt.
Select user,password,host from mysql.user;
Result = shows root user 3 times and OPIDBuser 2 times.
The following commands use a DB user name of 'OPIDBuser’ as an example.

Update mysql.user set password=PASSWORD('YourNewPWgoesHere') where
user='OPIDBuser’,

Result = When successful it shows: 'Query OK, 2 rows affected"
Select user,password,host from mysqgl.user;

Result = the hashed PW for OPIDBuser should now be different than in step 3
above.

7) Exit MySQL.

Then change it to match on the OPI side.

See the OPI Installation and Reference Guide for more details on how to change the
database user password on the OPI side.
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Troubleshooting and FAQs

Troubleshooting

Situation 1: Cannot communicate to OPI after installation.

Test: Verify you can telnet to the OPI PC on port 5098 from another computer.
Example: From CMD prompt: telnet 192.0.2.1 5098

Where 192.0.2.1 is the IP address of the OPI server.

If you cannot telnet to the OPI port, try the following:

* Restart the OPI Service.

*  Temporarily by pass the firewall.

*  Verify OPI is listening on port 5098.

* Open CMD prompt: C:\>netstat —anob > c:\temp\ports.txt and then search for 5098.

Situation 2:

-

Error

This generic error message can be caused by several things.
Solution 1: Restart the OPI Service and try again.
Cause:

If the system.log shows the following message, the cause is likely a Java security update.
(This should not be an issue in OPI 6.2, but leaving info, in case.)

[GATEWAY RESPONSE] GenericJSONProcessor : Cannot decrypt
java.security.InvalidKeyException: lllegal key size

Not all Java updates cause this error, but security updates can cause it.
Solution 2:

*  Stop the OPI service.

* Go to the link below and download jce_policy-8.zip.
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http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-
2133166.html
° Unzip the file and copy the two files to your Java security folder.
- Local_policy.jar
- US_export_policy.jar

Example: C:\Program files\Java\jre (your current
version)\lib\security\

° Start the OPI service.
Situation 3: “Issuer or switch inoperative”
Cause 1: Simulator is not running.
Cause 2: OPI service not restarted after making config change.
Cause 3: Java security update broke OPI by replacing files.
This should not be an issue in OPI 6.2.
Cause 4: Incorrect Proxy settings.
Cause 5: Wrong PSP configuration.
Solution 3: LaunchConfiguration.bat | PSP Configuration
1) Verify using https instead of http.
2) Verify URL is correct. Append the port to end of host value.
Ex: Host = https://192.0.2.1:8991
Cause 5: Wrong IP address for that terminal.
Situation 4: “Bad Terminal ID”
Cause 1: In LaunchConfiguration.bat wrong Merchant ID
or wrong workstation number.
Cause 2: Wrong Merchant ID.
Cause 3: In OPLinc if "Multi Merchant = FALSE" then the
"merchantlD" value below it cannot be empty.
Cause 4: In OPL.inc no mid or wrong mid. rvc_mid[1] =""
Cause 5: MGDH.inc has some wrong value. These below are correct.
HOST1 = https://192.0.2.1  (Wrong URL/IP)
PORT1 = 5098 (Wrong port)
URL1 = GDIPOS (Wrong solution)
Solution 4: Verify no old OPLl.inc is left over in CAL\Files\Micros\Etc.
Verify the correct values are in OPL.inc in CAL package.
Install that MGDH CAL package on that workstation again.

Cause 6: Forgot to restart OPI service after making changes in config.exe or the wizard.

6-2


http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html

Chapter 6
Troubleshooting and FAQs

Situation 5: Cannot enable/disable the signature prompt.
Solution 5: For live sites this should be controlled by the PSP.

For OPI 6.2.0.0.13 simulator add this value to
properties\SimulatorConfig.properties: ENTRY_MODE=05

Restart simulator.

Not Supported

° Incremental Auth
* Void a Refund (RES Limitation)
*  Backup OPI Server

* Voiding the tender from a SaleCashBack transaction
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